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Edit View Project Debug Tools Window Help
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(Global Scope) - % main(void)

[ Selution 'Ex-01-01' (1 project) E#tinclude<stdio. h>
4 [ Ex-01-01 2 | #include<conio.h>

b (57 External Dependencies 3
[ Header Files 4 Evoid main(void)

[ Resource Files
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printf( Helcome to C Programming”);
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(Global Scope) -
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[=]
=
H

3
4] | main()
5

B Output

Ready

TR 5. o o :
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2010 Express L@ Borland Turbo C++ 4.5 for Win

Microsoft Visual C++ 2010 Express Edition

lumldewail fdeudenesunanisiasouaz e Microsoft Visual C++ 2010 Express Edition
weifanuanusnld Microsoft Visual C++ waffulafils laidrazilu Microsoft Visual C++ 2008 Express
Edition /30 Microsoft Visual Studio 2010 ddlidnazldinefiila Msiuadwgniaineuaesitsunsud
Tadpnariu

la8audanoud@add Microsoft Visual C++ 2010 Express

fiauNazAnFaLAsasila Microsoft Visual C++ 2010 Express Hanuazfiaddnsaninuniantas
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a1oulhaa Microsoft Visual C++ 2010 Express

TalsUunsu Microsoft Visual C++ 2010 Express 7ianazldlumisdaianil ultlsunsunefiu

nanadldsuaasiisunsu Microsoft Visual Studio 2010 Feganuannsnldisunsulunesduniuansiig
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fuld marznanisineureslAnllsunsusiuasdnad ldunnsneiu

Tuaddu Microsoft Vlsual C++ 2010 Express mmummmmqu“immimwLau"Lsnm http://www.

microsoft.com/express/Downloads/ mmumumu

waniiiwa http://www.microsoft.com/express/Downloads/ 1aan Visual C++ 2010 Express

2. ludau Select language...

I itp

\@an English

B

s Favorites | 5 * Google

‘[5 Microsoft Express Downloads - isual Studio Expr... | |

o v [ @ v Pagev Safety~ Tookv @~

Select language...
[setect language. ..

» [Chinese - Simpified
Chinese - Traditional
» |Frencn
German
¥ |itaian
Japanese.
¥ korean
Russian
panish

OO Visual Studio 2010

Express

Although Microsoft™ Visual Studio® 2010 Express products are
provided free of charge, we do require that you register your product
within 30 days of installation for continued use. I you are not sure
how to obtzin your free Visual Studio 2010 Express registration key,
follow these instructions.

P Visual Basic 2010 Express

Download Visual C++ 2010 Express

L:é Visual Studi
n___ _ Professional

exploring the new opportunities that await you today.

P Learn More » Download Trial Version

P Visual C# 2010 Express

P Visual C++ 2010 Express (-

io 2010

Learn more about the new features and enhancements in the Visual
Studio 2010 product family by visiting the Visual Studio site. Also see
the new benefits you get when you become a MSDN Subscriber. Start

Microsoft. Visual Studio. LightSwitchw

gives you a simpler and faster way to create professional-quality

DOWNLOAD
B

a
Laan

S|

e Pack (CLIP)

business applications for the desktop, the web, and the cloud.

o0
Visual Studio
LightSwitch

@ Intemet | Protected Mode: Off

A v R100% v

3. aztsnglnezdentend File Download
4. adniy Wadeniuinnamass

w
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i #Iu.l‘i;& \i]l n

Do you want to run or save this file?

(E

Name: vc_web.exe
Type: Application, 316MB

From: download.microsoft.com

Run ] l Save j l Cancel ]

While files from the Intemet can be useful, this file type can
potentially ham your computer. F you do not trust the source, do not
run or save this software. What's the risk?
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aadblusiinsu Microsoft Visual C++ 2010 Express

Fal1l3unsy Microsoft Visual C++ 2010 Express H3ann3fmsalilsunsusail
1. WeFanlillsunsumnsisazianglnezdendend Microsoft Visual C++ 2010 Express Setup
2. pdnyu

Welcome to Setup

Microsolte
QO Vistal C++2010
Express
Welcome to the Microsoft Visual C++ 2010 Express installation wizard, Microsoft Visual C++ 2010
Express indudes the 32-bit Visual C++ compiler toolset and an optional lightweight development

environment. This wizard will guide you through the process to install this program and any
prerequisites needed on this computer.

Help Improve Setup
You can submit information about your setup experiences to Microsoft. To
participate, check the box below.

Yes, send information about my setup experiences to Microsoft Corporation.

: < Previous | Mext >

(i) For more information, click Privacy Statement

3. AANWABN | have read and accept the license terms

4. panty

License Terms

OO Visual C++2010
Express

Be sure to carefully read and understand all the rights and restrictions described in the license
terms. You must accept the license terms before you can install the software.

MICROSOFT SOFTWARE LICENSE TERMS -
MICROSOFT VISUAL C++ 2010 EXPRESS D

These license terms are an agreement between Microsoft Corparation (or based on where
you live, one of its affiiates) and you. Please read them. They apply to the software named
above, which indudes the media on which you received it, if any.

Tha tarme alen anchs tn anw b £ )

Press the Page Down key to see more text.

7\
wan 3 ’ (@ I have read and accept the license terms

(7 I do nat accept the license terms

< Previous. mxt>_l Cancel

w
(V]
=4
a




5. AANM WaBuiu 3 [

AnFalLsuna Destination Folder OO Vistal C++2010
Express

Installation location cannot be changed. Click here for more information.

Install in folder:
IC:\Program Files\Microsoft Visual Studio 10.0% ‘ ‘ Browse... |

The following items will be downloaded and installed:
+ Microsoft Visual C++ 2010 Express

Disk space requirements; C: 737 MB

Total download size: 68 MB
< Previous, mmll = I Cancel

6. AUlanFRAARIlLTWNIN

Download and Install P Microsols
miesce — OO Vistal C++2010
Express

The following item(s) are being downloaded and installed on this computer:

o =

B Il Microsoft Visual C++ 2010 Express

Currently Downloading (1 of 1): Microsoft Visual C++ 2010 Express
Status: Current transfer rate is 327 KB/sec.
Total Download Progress: 45MB {638 MB

v
a o

7. Ansaldsunsy

Download and Install P Microsole
rloata o OO Vistal C++2010
Express

The following item(s) are being downloaded and installed on this computer:

9 =

v Ep Microsoft Visual C++ 2010 Express
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8. WamasslisunsuGaufeaudn Taanilu

Seti let: iy i
CA GO Visual C++ 200
Express

Microsoft Visual C++ 2010 Express has been installed successfully.

(i) Visit Microsoft Update to download the latest service packs and security updates.
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ISuduIdguldsinsunmu C dog Microsoft Visual C++
2010 Express
lemndatilsunsn Microsoft Visual C++ 2010 Express t@5aiFas¥aauan AN Gududey
TWsunsunnn ¢ u Tnefduneunnsdaugl
1. FanldlUsunsn Microsoft Visual C++ 2010 Express ﬁfmmi‘ﬁaﬂﬂqu Start > All Programs >
Microsoft Visual Studio 2010 Express > Microsoft Visual C++ 2010 Express

&2 Windows Fax and Scan
 Windows Media Center
indows Media Player
EJ Windows Update Documents
oA XPS Viewer

| 7-Zip Pictures

editor-joe

. Accessories

| i Music

. Games ~

| Meintenance Lomputer

. Microsoft Office

| Microsoft Silverlight 3 SDK

. Microsoft SQL Server 2008

. Microsoft Sync Framework

| Microseft Visual Studie 2010

. Microsoft Visual Studio 2010 Express
2] Microsoft Visual C++ 2010 Express
@ Try Visual Studio 2010 Professional
[ Visual Studic Commeand Prompt (20

. NetBeans

. Sierra Wireless

. Snaglt8

. Startup

Control Panel

Devices and Printers

PAGE

4 Back

[ search programs and fites




2. maBanldlusunsnlunfousn Tsunsuazinvuadnsine Addu

Microsoft*
w Visual C++2010 Express

Microsoft Visual C++ 2010 Express

icrosoft Visual C++ ress is loading user settings. This may take
i) Microsoft Visual G+ 2010 Express is loading ings. This may tak
a few minutes.

[

‘Evaluation purposes only.

ew Debug Tools

Start Page X

Migrpsoft
OO Visual C++2010 Express

[F NewProject...

[ Open Project...

Get Started | Latest News
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Welcome Learn  Upgrade

E— = Welcome to Visual C++ 2010 Express
Recent Projects The tradition continues! Visual C++ 2010
Express helps developers quickly create
exciting interactive applications for
Windows. With the new Visual C++ 2010
Express development environment,
improved performance, and lots of new
features, moving from grest idea to great
application has never been easier. Kick off
your learning at the Beginner Developer
Learning Center, or find the latest and
coolest projects on Coding4Fun.

Beginner Developer Learning Center
Coding4Fun
More on Visual C++ 2010 Express

=1 Quickly Create Your First Application

What's New in Visual C++ 2010 Express.

Close page after project load
Show page on startup

Ready

g1 Recent Templates 1aen Visual C++ > Win32
\@an Win32 Console Application
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Recent Templates

Sort by: | Defutt | Search Installed Templates

Installed Templates

Type: Vi I C-
@ Win32 Console Application  Visual C++ R
4 Visual Co+ = A project for creating a Win32 cansole

R spplication
wmz( Aan . Win32 Project Visual G+

General

5
‘ PNTR
e Ex00
Location: c:{useu\em,{oé\'uesictob\( ’ ﬁwumﬁﬂq‘ -
Solution name: Ex00 Create directary for o/

9. AANL«

Welcome to the Win32 Application Wizard

Qvervien These are the current project settings:

Application Settings & Console application
Click Finish from any window to accept the current settings.

After you areate the project, sec the project’s readme. it file for information
about the project features and files that are generated.

10. A@ANLAEN Console applica-

tion Application Settings
11. ﬂaﬂ Lﬂ?‘@ﬂﬂﬂﬂﬂgﬂﬂﬁﬁ
Em pty prO]eCt Owervisw AD!)UEDM type: Add commen header files for:

indows application

) Console application
LL

Application 5~ 7
den @)
taticbrary
Additional options:

12. AANLY
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13. Winlndn1m ¢ Wunlulusdns Ineadanaani Source Files > Add > New ltem...

File Edit View Project Debug Tools Window Help

e e e e B R | T |- )

. |l Solution Explorer v 1 x
[
m Solution 'Ex-00" (1 project)
4+ [JEBc-00
4 Extemal Dependencies
[ Header Files
[ Resource Files
|3 Source File

0 usWnog

au

Add 2 New lem... Ctrl+Shift+A
Cut Ctrl+X = Existing ltem.. Shift+Alt+A
Copy Ctrl+C New Filter

Paste Ctrl+V Class...

Delete

Rename

Properties

Creating project

14. ludqu Installed Templates 1d@n Visual C++ > Code
15. 1@an C++ File (.cpp)

16. fanald

17. p@ANIW

Installed Templates

Sort by: | Defauit | Search Installed Templates

4 Visual C++
F Type: Visual C
"] Ces File(cpp) Visual C++ Lde bl b

u
=
cm( ﬁ Aen Creates a file containing C+ + source code
Property Shee @ Header File (.h) Visual C++
@ Component Class Visual C++

Name:

Location: C:\Users\editor-joeh Desktop,Ex-00\Ex-00 - ‘ ,
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TIPS Tupsaliganusiadniaidoulusunsunien C++ gaugusavialaragdsnsifeaiuiunis
Weouldsunsunien C uAazuanAniutiiesunuanavaslnduuenstaldiniu lvidonus
unuanazadlWaidu .cpp Aegu

Installed Templates Soby (Default <] 44 [ Search Installed Templates 5|
4 Visual C++ -
E “ . Type: Visual C
e Windows Form Visual C++ TSy
= Creates afile containing C++ source code
Code . L
Data B C++ File (.cpp) Visual C++
Resource
Web @] HTML Page (htm) Visual Co+
Utility —
Property Sheets Static Discovery File (disco)  Visual C++
@ Header File (h) Visual C++
J@ Midi File (idl) Visual Cos
| ResourceFile (xc) Visual G+
LE RN
Name: Test.cpp < Autiping
Location: DAC\Test\Test\ « | | Browse..

18. AnvilAnTUsunsusail

#include <stdio.h>
#include <conio.h>

main()

{
printf("Introduction C Programming");
getch();

19. adandn B Weduldsunsy

File Edit View Project Debug Tools Window Help

R = = MR S R ] ~ [ winz2 -] 2

=3 (Global Scope)

33 Solution 'Ex-00 {1 project) S#include <stdio.h>
4 FAEc00 #include <conio.h»
» fgd Extemal Dependencies
£ Header Files | weial)

[ Resource Files {
a [ Source Files
& BxD0.c

auipng uawndoq & |

printf("Introduction C Programming”);
getch();

B Output

Ready




20. azisnglnezfendend Microsoft Visual

C++ 2010 Express laANLATaSMMIEgNUi This preectis outof date

Ex-00 - Debug Win32

Do not show this dialog again

21. AdAni

o

22. lFnadngsail

Would you like to build it?

P vs J[ Mo ][ conca

[ Do not show this dislog again

nmsuunniusidnd (Save Project)

metiuiin (Save) Tilsidnsia¥1e@unn arwnsavinldlaepdnuuy File > Save All ¥50@1130

1%

Yy A . A Ay = - P o
1 NAEAR (ot + | shift [+| s | ‘Wﬁ"ﬂﬂ@ﬂﬂqﬂ E nyauT ma%zimmaawmumunu

File | Edit View Project Debug Tools Window Help

New
Open
Add

Close - % main(void)

<stdio.h>
Save Ex-01-01.c Ctrl+S <conio.h>
Save Ex-01-0L.c As...

Save All Ctele Shift+S

Close Solution

n(void)

tf("Helcome to C Programming”);

P Setup...
b n();

Print... Ctrl+P
Recent Files

Recent Projects and Solutions

(Global Scope)
[ Solution 'Ex-00° 1 project) S#include <stdio.h>
4 [Jlecoo #include <conie.hx
» (g1 Bxdemal Dependencies .
[ Header Files | o

[ Resource Files {
4 [ Source Files

€ Ex-00.c | 3

printf("Introduction C Programming”);
geteh();
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B Output
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nisidalusidnd (Open Project)

feuannsnidlallsdnimilagudaaunninauls Taaagniy File > Open > Project/Solution...

vizaaNIn INALAR (et (s« (o) vizap@nyn B Nyaund Teaslduadndinieniu

File | Edit View Debug Tools Window Help

Brit AlteF4

8 Ex-01-01
8 B01-02
Close page after project load
Show page on startup.

B Output
Ready

New » ‘
Open * | @ Project/Solution.. Ctrl+Shift+O
Close (5 File.. Ctrl+0
Z1 Close Solution
[ Save Selected Htems Ctrl+S al C++2010 Express
Save Selected Ttems As.
@ saveAl Ctrl+Shift+S
D [ Get Started | Latest News
S Print.. Ctrl+P Welcome Learn  Upgrade
Recent Files O
Recent Projects and Solutions v

Open
.« IDC » C» Ex » Chl » Ex0101 » + |43 || Search Ev-01-01 o
Organize »  New folder = 0 @
o Music 2l Name Date modified Type
& Pictures )
|| Debug 10-Feb-12 23:15 File folder
B videos
)| Bc01-01 10-Feb-12 23:15 File folder
I ipch " - . = ady a
Y Homegroup ey Lﬂﬂﬂiﬂﬂ Solution mnimmwmwmmummmi
(1 Ec01-01.sdf ol
|7 ec01-01.5in 03-Nov-1016:52  Microsoft Visual Studio Solution
1% Computer 1 = -
= Ex-01-0Lsuo 04-Nov-1017:05  Visual Studio Solution User Options
&, Local Disk (C3)
s Local Disk (D)
(= Local Disk (E)
&3 CD Drive (H:)
-~ I | J

File name: Ex-01-01.5ln

~ | AllFiles (*2) -

J

NMsSIBgumMosu1g (Comment)

al o a = 6 o v a dl v
ma@euAnesunanelullsunsy aziidsvlamifug@eulisunsy Wasang@aultsunsy
gausadsuaesualfallsunsnnielullsunsnls Tasflidnananisineuaasilsunsy vinli
v = i/ﬂl o v o 2 d? dl aaal al ) a
fasulisunsueavieowinanudnlallsunsalumenasliinetu Gannm ¢ §35nsdisuanedung
e lderasnung /¢ ¥ AseudiuaesdanInuiieseanisiiuaietune WsedeuesesuNng / /
YNNI AT FR9N3ANE s LRI atingsia TT

#include <stdio.h>
#include <conio.h>

PAGE

//Ae8uelanlusunsuy
void main()

{

int count, sum, n;




printf("Enter integer : ");
scanf("%d", &n);

sum = 0;

/% quguiiteuimmdmasi
fhedradu 1 + 2 + 3 + 4 Judu %/

for (count = 1; count <= n; count++)

{

sum += count;

printf("Sum = %d", sum);

getch();

NOTE

luntdsdaiauilifontdirdasile Microsoft Visual C++ 2010 Express Edition

Borland Turbo C++ 4.5 for Win

=

Twirdalifdauaanesunanisinsuas 149U Borland Turbo C++ 4.5 for Win ivarilumng
A Yo Y 1Yo ¥ ‘ﬂ' A o A oo = @ v 43' v
wanliiuge uidauaunsnldirresdedalavanefiulaluniadaullsunsunim ¢ Al Sl
rannsvineueedlysunsulisniu

NOTE

&MTUAIARAY Borland Turbo C++ 4.5 for Win Hidauldimsaulily CD wowvineiau

aaavlusiinsu Borland Turbo C++ 4.5 for Win
#aTsunsn Borland Turbo C+ 4.5 for Win SAannsAnselLsunsusail
1. suidaranlud INSTALLEXE Tulnamasinanasalilsunsy

.« Borland Turbo C++ 4.5 for Win » Borland Turbo C+= 45 for Win < [ 43 [ search Boriand Turs... £
Organize ¥ Open  Bum  MNewfolder =~ [ @
3 e - MName Kk ° Date modified Type Sze |
|| IMAADPCMLAC_ U2-5ep-94 0000 AC_Hle
< 8 Downloads 3
a [1mcpak 2B-Apros0sS0  PAKFile
% Recent Places
7] INCSYS.PAK = = )28-AprS50550  PAKFile
[ Desktop ALLLARAN
[ MwPD.OL_ ‘ 19-Nev-030000  DL_File
B [85] INSTALLEXE 28-Apr9505:50  Application
ﬂ@';m E| & INSTALLINI 28-Apr-95 05:50 Configuration settings o
it:
n M““me" 3 5 INSTALLTXT 28-Apr9505:50  Tedt Document
= | INSTANCEPAK 28-Apr-95 05:50 PAK File
EI L= 1 TINSTRUN.FX 78-Anr-95 05:50 FX File
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2. azdsngurisinelusunsusiagy

Welcame to the Setup Program for Micresoft Video

for Windows 1.1

This program will install the Video for Windows
runtime to allow you to play video in Microsoft
indows.

If you have any questions about installation, select
the help button for more information.

4. avdsngurisinglilsunsusiagy
5. AANLN e HunsAasalsunsu

we Video for Wi 1 Runtime

icrosoft Video for Windows Setup

Setup Successful

ﬂ Installation it complete.

6. azUsngwii1s Turbo C++ Installation

7. AANUM

——
Turbo C++ Installati

INSTALL. TXT tains important inf tion about installi
and configuring Turbo C++.

You can view INSTALL TXT now. or at a later lime by
viewing it in Motepad.

INSTALL.TXT can be found on the CD-ROM drive under
\TCWINAS.

To view INSTALL. TXT now, choose Continue or press Enter.
To skip INSTALL TXT, choose Skip.

To cancel installation, choose Cancel.

For more information, choose Help.

ﬁkip‘l | Cancel | | Help I

AAN
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8. wangUuuunisAnssltlsunsa
9. hanlasfnsasnishinsalisunsy
10. AaNLu

EOF

Select a Turbo C++ install configuration.
Choose one of the following:
@ Full

) Custom
) CD Only

Installs all files, including Help.
Installs only the file sets you select.

Installs only the file sets needed to run from your CD.

Select the default install

desired drive letter in th

rAvailable Drives: ‘
C:LOCAL DRIVE
D:LOCAL DRIVE
E:LOCAL DRIVE

ag Turbo C++ by highlighting the

:

472.68 HB FREE
184.89 HMB FREE
837.58 HB FREE

To continue installation, choose Continue or press Enter.
To cancel installation, press Cancel.

1. S2yAUINNFRBINNIAARS
Tusunau

12. AanLu

N

13. AANLN

For more infi choose Help.

[ Cancel | [ Hep |

iContinue:

Install will place Turbo C++ into the following directory on
your hard diive. To install Turbo C++ in a different directory,
specily the path below.

Install to: [CATCWINAS < ﬂ

CD-ROM Drive: E
Windows Directory: C:\Windows

Optlions:
[ Windows LAN setup
% Online Documentation

DOnline Documentation Directory:
|CAACROREAD

To continue installation. choose Continue or press Enter.
To return to previous screen, choose Previous.
To cancel installation, choose Cancel.

For more information, choose Help.

Previous I | Cancel I | Help I

You are now ready to install Turbo C++.

Total Dizk Space Required : 74928 KB

471932 KB

Available Disk Space:

To install Turbo C++, choose Install or press Enter.
To return to previous scieen, choose Previous.
To cancel installation, choose Cancel.

14. AdNYW

loissuidisulusinsumu € aduauysnd
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For more inf choose Help.

| Previous I| Cancel ” Help I

README.TXT contains important information about Turbo
C++ which iz not covered by the printed documentation.

“ou can view the README file now, or at a later time by
wviewing it in Notepad.

To view README . TXT, choose Continue or press Enter.
To skip README.TXT, choose Skip.

To cancel installation, choose Cancel.

For more information, choose Help.

iContinue I ‘ §kip_|




15. AanLy

[Reminder!

The online documentation icon has been installed.
Remember to run:

E:\INSTALL\ACROREAD.EXE
to install the Adobe(tm) Acrobat{tm] Reader, and make

sure the d path is: ‘E manj
(=

C:MACROREAD

16. AANLYN |

T

Turho C++ is now installed.

Install has updated the PATH statement in your
AUTOEXEC.BAT file for you

Make sure the line: FILES=40 is in your CONFIG.SYS file.

Remember that you must exit Winy ot your
machine in order for the installer pdn | eeet

17. A@NLN nsAnFInAzIaTaaNysnl

Turho 6’++ux\%

Register Now!

Register your copy of Turbo C++ and you will
be among the first to learn about new product
information, enhancements, and accessories.

Only personal information, such as your name
and address, and information about your system
i ion is uploaded during the regi: i

oK

process.

ISuduIdsulusiinsuniy C do8 Turbo C++ 4.5

amnsalLlsunsy Borland Turbo C++ 4.5 for Win 1@§aBeusasudn wfnnEusmudaulilsuns

o <% % o X
e € i Tneddunaunis gl

1. Waldsunsy Turbo

~
wen @l

C++ IneA@ny)s Start > All Programs > Turbo C++ 4.5 > Turbo C++
‘

Startup {
Turbo Ce+ 45
&2 Borland Custom Controls
K2 Class Library Reference
K2 Control 3D Reference
2 Creating Help

[E] Fconvert

K2 ObjectCompenent Reference
2 ObjectWindows Reference
[#] OpenHelp Configuration
& OpenHelp

K2 Programming Tips
8 Quick Tour

[2] Register TCW 4.5
K2 Resource Script Reference
K2 Resource Workshop Reference
[T°7 Resource Workshop.
2 TCW and Library Reference
> 1 Turbo Co+
K2 Windows API Reference
|2 Winsight Reference
[ Winsight

K2 Winspector Reference
=7 Winspector

UttralsO

USBAntivirus

NEVER-DIE
Documents
Pictures
Music
Games

Computer

Devices and Printers
Default Programs

Helpand

w
V]
=4
a

4 Back

Shutdown | » |

|Search programs an
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2. avdsngurisinglusunsusagy

Debug Tool Options Window Help

#include <stdio.h>

vold main(veold)
{

printf ("Introduction C Programming™);
i3

«fl Debug Tool Options Window Help
AppExpert...

Mew project...
Open project...

#include <stdio.h|
Close project
wvold main(void)
{

printf ("Introdu
1

w
Y]
=
a

Make all
Build all

fgierissuidsulusinsumu € aduauysad

oW (.4
gl .



TIPS

fanuanunsn Compite Tsunsuldlaanayuddan (a Jor) Ndduasa

5. winldsunsuiiBaugnaesnuudnloannsnizeanim C azlinadngaag

6. AANLMN

#include <std:

vold main{void
{

printf ("Int
H

Step over

Trace into

#include <stdio.h>
Toggle breakpoint ~ F5

veold main(vold) Find execution point

& . . Pause prograrm
) R Terminate prograrn Chrl+F2

Add watch... Ctrl+FS
Add breakpoint...

Evaluate/Modify...  Ctrl+F7
Inspect.,

Load symbol table..,

Make and run the current prograrm

TIPS

w
o
I
a
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